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How to Edit a Screenshot

This wikiHow teaches you how to capture and edit a screenshot on an Android, iPhone, iPad, Mac, or Windows
PC. Press and hold the Volume Down and Power buttons simultaneously. After 1-2 seconds the screen will flash
indicated a screenshot...

Method 1 of 8:

Using Google Photos for Android

1.

Press and hold the Volume Down and Power buttons simultaneously. After 1-2 seconds the screen
will flash indicated a screenshot was taken.

1. The key combination may vary depending on your phone or tablet. On some Android models, you'll
have to hold the Home and Power buttons.

2. If you're using Android 9.0 or later, you can also take a screenshot by holding down the power
button until a menu appears, and then tapping Screenshot.[1]

3. If you only need to crop or draw on your screenshot, you may be able to do this immediately after
you take the screenshot on Android. Simply click the pencil icon on the preview of the screenshot to
draw on it or the crop symbol to change the size of the screenshot before you save it.
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2.

Open Photos. It's the white icon with a multicolored flower inside (labeled Photos or Google Photos).[2]

1. If you don't have Google Photos on your Android, you can download it now from the Play Store.

3.

Tap the screenshot to open it.



4.

Tap the edit button. It's the second icon at the bottom (the three lines with sliders) of Google Photos.

5.

Select a filter. If you'd like to apply one of Google Photos' preset color/lighting filters, select an option
from the row at the bottom of the screen. Swipe left across the examples and tap the one you want to use.



6.

Tap

to crop and/or rotate photo.
1. Crop: The screenshot is surrounded by a border with white dots at each corner. Drag the dots until

only the part of the image you want to keep is surrounded. The crop will happen automatically
(though you can drag the dots back outward to undo your changes.

2. Rotate: Tap the curved arrow icon at the bottom-right corner until the image appears as you like.



7.

Tap Done  to save your changes. If you'd like to edit the colors and lighting effects, continue with
this method.

8.

Tap the edit button. It's at the bottom of the screen (the one with sliders and knobs). This opens the
lighting and color options.



9.

Adjust the lighting and color. Use the sliders to adjust the lighting and color of the screenshot if desired.
1. Slide the 'Light' slider left to make the image darker, or right to increase its brightness.
2. Slide the 'Color' slider left to decrease the intensity of the colors, or right to make the colors very

saturated.

10.

Tap Save  when you're finished. If you didn't make any changes (or don't want to save them), tap the
X at the top-left corner, and tap Discard if prompted.

Method 2 of 8:

Using a Samsung Galaxy



1.

Press and hold the Volume Down and Power buttons simultaneously. After 1-2 seconds the screen
will flash indicated a screenshot was taken. The image will be saved to your gallery.

1. The key combination may vary depending on your phone or tablet. On some Android models, you'll
have to hold the Home and Power buttons.

2. If you use Google Photos on your Galaxy, see this method instead.
3. If you only need to crop or draw on your screenshot, you may be able to do this immediately after

you take the screenshot on Android. Simply click the pencil icon on the preview of the screenshot to
draw on it or the crop symbol to change the size of the screenshot before you save it.

2.

Open the Gallery app. The icon usually has a yellow flower, and you'll find it in the app drawer.
1. If you see a preview of the screenshot right after you take it, you can tap it to open it in the editor

without having to open the Gallery.



3.

Tap the screenshot to open it. Several options will appear along the bottom of the screen.
1. The remaining settings will vary depending on your version of the Gallery app, as well as which

model of Galaxy you own.

4.

Tap Edit  (the pencil icon) or the icon with three-bars. The option you see will look different
depending on your version.[3]

1. If you already see some editing tools at the bottom of the screen, you won't need to complete this
step.



5.

Crop the screenshot. Tap the crop icon (a square with two longer lines at two of its corners) at the bottom
of the screen, or the Adjustment option. Drag the box to surround only the part of the screenshot you
want to keep, and then tap SAVE or the check mark.[4]

6.

Rotate the screenshot. To do this, tap the ? menu at the top-right corner, then select Rotate Left or
Rotate Right as needed.



7.

Make additional edits as needed. The remaining options vary by model, but you'll usually find options to
choose a filter (usually under Effect), adjust colors (often called Tone), and draw on the image using a
tool called Drawing.

8.

Tap SAVE  when you're finished editing. This saves the changes to your screenshot.

Method 3 of 8:

Using the iPhone or iPad Screenshot Markup Tool



1.

Press the Home and Power buttons simultaneously to take a screenshot. The screen will flash briefly
and a preview of the screenshot will appear at the bottom-left corner of the screen.

1. If your iPhone doesn't have a Home button, you can take a screenshot by pressing the Power and
Volume-Up buttons.

2.

Tap the screenshot preview. It's the small image at the bottom-left corner. This opens the screenshot in
the Markup tool, which displays several editing icons at the bottom.

1. The preview will only stay at the bottom-left corner for a few seconds before disappearing. If it
disappears before you tap it, follow these steps to open it in the Markup tool:[5]

1. Open the Photos app.
2. Tap the screenshot.
3. Tap Edit at the top-right corner.
4. Tap the three dots icon.



5. Tap Markup (the icon of a marker at the bottom).

3.

Drag the blue borders to crop the screenshot. Drag the blue lines to surround only the part of the
screenshot you want to save, if desired.

4.

Draw on the screenshot. Here's how:
1. Tap one of the drawing tools (the marker, highlighter, and pencil icons at the bottom-left corner) to

select it.
2. Tap the tool again to choose a line width and weight.
3. Tap the filled-in circle to select a color.
4. Use your finger to draw on or highlight certain areas.
5. Tap the drawing tool you select at the bottom-left corner to return to the tools list.
6. If you made a mistake in your drawing, tap the pencil eraser tool at the bottom and then tap the error

to delete it.



5.

Tap the Text  tool to type on the photo. If you don't see the 'T' at the bottom of the screen, tap the +
at the bottom-right corner to expand more options, and then tap Text.

1. Tap the filled-in circle to choose a text color.
2. Tap aA icon to choose a font face, size, and alignment.

6.

Add shapes to the screenshot. Tap the + at the bottom-right corner, then tap the square, circle, chat
bubble, or arrow to add these shapes to the screenshot.

1. Use the filled-in circle at the bottom to select a color.



7.

Add your signature. If you need to sign the screenshot, here's how you can do that:
1. Tap the + at the bottom-right corner
2. Tap Signature.
3. Use your finger to sign your name at the bottom (or select your signature if you've already created

one).
4. Tap Done at the top.

1. If your signature doesn't appear, tap Signature again, then tap your signature to place it.
5. Drag your signature to the desired position.

8.

Use the magnifying glass. If you'd like to increase the size of one area of the screenshot, tap the + and
select Magnifier. You can then use your fingers to position or change the size of the enlarged area.



9.

Tap Done  when you're finished editing. It's at the top of the screen. A menu will expand at the
bottom.

10.

Tap Save to Photos . This saves the screenshot to the Photos app.

Method 4 of 8:

Using the iPhone or iPad Photos App



1.

Press the Home and Power buttons simultaneously to take a screenshot. The screen will flash briefly
and a preview of the screenshot will appear at the bottom-left corner of the screen.

1. If your iPhone doesn't have a Home button, you can take a screenshot by pressing the Power and
Volume-Up buttons.

2.

Open the Photos app. Your screenshot is saved to this location by default.



3.

Tap the screenshot to open it.

4.

Tap the 'Edit' button. This button is located in the upper right corner of the screenshot and will bring up
a variety of editing tools.



5.

Tap the Magic Wand icon to make auto changes. This button is in the upper right corner of the screen
and will automatically make color and lightning adjustments to the screenshot.

6.

Tap the Dial icon to adjust color, light, and balance. This button appears in the bottom toolbar and will
bring up 3 menus: 'Light', 'Color', and 'B&W'.

1. Each category will have a submenu with a number of options that can be adjusted with a slider.



7.

Tap the 'Filter' icon to add artistic filters. This icon is represented by 3 overlapping circles and is
located on the bottom toolbar.

1. Filters like Mono, Tonal, and Noir will add a black and white stylized filter.
2. Filters like Fade or Instant will give the screenshot a washed out, retro look.

8.

Tap the 'Rotation Icon' to crop, zoom, or rotate the screenshot. This icon is located on the right of the
bottom toolbar.

1. Tap and drag the corners of the picture space to crop the picture.
2. Adjust the slider to manually rotate the photo or press the 'Rotate' icon (square with a curved arrow)

to automatically rotate 90 degrees.
3. Reverse pinch the photo to zoom.



9.

Tap 'Done' to keep your changes. This button appears in the lower right corner after changes have been
made.

1. You can undo your changes by tapping 'Cancel' in the lower left corner and selecting 'Discard
Changes'.

2. You can undo changes after saving by selecting 'Revert' which appears in place of the 'Done' button.

Method 5 of 8:

Using the Windows Snipping Tool

1.

Type 'Snipping Tool' into the search bar. You can usually open the search bar by clicking the circle or
magnifying glass to the right of the Start menu.



1. Microsoft plans to discontinue the Snipping Tool in a future release. This tool will be replaced by
Windows Snip and Sketch.

2.

Click Snipping Tool  in the search results.

3.

Click New . It's at the top-left corner of the window. The screen will appear slightly faded and mouse
cursor will change to a selection tool.



4.

Click and drag the mouse to select the area you want to screenshot. When you release the cursor, the
image will be captured and open in the Snipping Tool.

5.

Click the pen to if you want to draw on the screenshot. It's at the top of the tool. You can use this to
write simple notes or circle areas of interest.

1. To select a color, click the small arrow next to the icon, then choose a color.



6.

Click the highlighter tool to highlight parts of the screenshot. You can then click and drag the tool to
highlight text.

7.

Click the eraser tool to remove changes. With the eraser tool selected, click a pen or highlighter marked
to remove it.



8.

Click File  menu when you're ready to save. It's at the top-left corner of the tool.

9.

Click Save As .



10.

Type a name for your screenshot and click Save . This saves your edited screenshot.

Method 6 of 8:

Using Windows Snip and Sketch

1.

Open Snip & Sketch. Snip & Sketch will be replacing the Snipping Tool as the default screenshot tool.
1. If you have the app installed, type snip  into the Windows search bar, then click Snip & Sketch

in the search results.
2. If you don't have the app, you can install it now for free from the Microsoft Store.
3. You must have the most up-to-date version of Windows to use Snip & Sketch.



2.

Click New . It's at the top-left corner of the tool if the window is expanded, or the bottom-left corner if
the window is smaller. [6]

3.

Take a screenshot. Choose one of these three options:
1. To capture a square or rectangular area of the screen, click the rectangle with a dot at the top-center

part of the tool, then draw a square around the desired area.
2. To draw a freehand line around the area you want to capture, click the curved line shape with a dot

(the second icon in the bar at the top), and then trace around the area you want to capture.
3. To capture the entire screen, just click the rectangle with darkened corners (the third icon in bar at

the top).



4.

Use the drawing tools. Click the pen, pencil, or highlighter tool near the top-center part of Snip & Sketch
to select a drawing tool, then tap the tool again to select a color and line weight. Use the mouse to draw on
the image.[7]

5.

Crop the screenshot. Click the crop symbol (the square with a diagonal line in the row at the top-center
part of the screen), then draw a box around the area you want to keep. Click the check mark at the top-
right corner to crop.



6.

Click the disk to save your w.ork It's near the top-right corner. This opens the Save As dialog, where
you can choose a new location and filename for your screenshot and then click Save.

Method 7 of 8:

Using Microsoft Paint (Windows)

1.

Press ? PrtScr  on your keyboard. This key will copy the contents of your screen to your clipboard.
1. If your keyboard doesn't have this key, you can use the one on the on-screen keyboard. Here's how:

1. Click the circle or magnifying glass to the right of the Start menu to open the search bar.
2. Type on screen keyboard , and then click On-Screen Keyboard in the search

results.



3. Click the PrtScn key.

2.

Press ? Win + R  and type 'mspaint' into the text field that appears. The Windows Run tool will launch
Microsoft Paint upon pressing 'OK'.

3.

Press Ctrl + V  to paste your screenshot into paint.
1. You can also paste by right-clicking the paint area and selecting "Paste".



4.

Click "Rotate" and select a rotation option. This button is located in the 'Image' section of the toolbar
and will open a menu to with different rotation options, such as vertical, horizontal, or 90 degree rotation.

5.

Click "Resize" to change the image size. This button is located in the "Image" section of the toolbar and
will open a window to set a new window size. Enter a new size value (e.g. 200% size) and press 'OK'.

1. You can select to adjust the size by pixel or percentage. Use pixel adjustments if you need a more
precise change.

2. Changing the size to be larger than the original will result in a loss of picture quality.



6.

Crop your screenshot. Click the "Select" option from 'Image' section of the toolbar. Click and drag to
select the area of the screenshot you want to use then click the "Crop" button the right of the 'Select' tool.

7.

Click the 'A' button to add text to your screenshot. This button is located in the tools section on the
toolbar. Click and drag to select a text area and type to enter your desired text.[8]



8.

Click the brush icon or select a shape to make markings on the screenshot. Both options can be
selected from the 'Shapes' section. Brushes can be used for freehand marking and shapes will make
markings in the shape selected.

1. You can change the color of the shapes and markers by selecting a color palette from the 'Color'
section.

9.

Open the 'File' menu and select 'Save As' to save your changes. You will be prompted to name the
screenshot and browse for a save location. Clicking 'Save' will confirm your changes.

Method 8 of 8:

Using Preview (Mac)



1.

Press ? Shift +? Command + 3  to take a screenshot. A screenshot will be taken of your current screen and
saved to your desktop.

1. If you'd like to capture a single window, press ? Shift +? Command + 4 , press the space bar, then click
the window you want to capture.[9]

2. To take a screenshot of a certain part of the screen, press ? Shift +? Command + 4 , and then click and
drag the mouse to select the desired part of the screen.

2.

Double-click the new file on your desktop. It's the new image file that contains date and time you took
the screenshot.

1. If your images open with a different app, press ? Command  as you click the file, select Open With
and choose Preview.



3.

Rotate the image. You can click the rotate button (the rectangle with a curved arrow near the top of
Preview) to rotate the image 90 degrees.

4.

Adjust the size of the image. Click the Tools menu at the top of the screen, and then select Adjust Size.
This allows you to change the height, width, and resolution as needed.



5.

Crop the screenshot. If you want to save just part of the screenshot, click the selection tool (the dotted
box near the top-left corner), and then click and drag the area you want to keep. Once selected, click the
Tools menu at the top of the screen, and then Crop to cut out everything but the selected area.

6.

Adjust the colors and brightness. If you want to get crafty, click the Tools menu and select Adjust
Color. You can use the sliders to adjust the exposure, contrast, highlights, shadows, saturation,
temperature, tint, and sharpness.

1. Your screenshot will reflect your changes as you make them, allowing you to experiment and find
the right mix of settings.

2. Exposure, contrast, highlights, and shadows will affect the brightness and black/white balance of the
colors.

3. Saturation, temperature, and tint will affect the intensity of the colors.



7.

Add text, shapes, and drawings.[10]

1. Click the A button near the top-right corner to open the text tool, and then click anywhere on the
screenshot to type.

2. Click the pen tool to draw.
3. Click the icon of a square and rectangle to insert shapes like triangles and circles.

8.

Click the File  menu when you're finished. It's at the top-left corner of the screen.



9.

Click Save .

10.

Enter a file name and click Save . Your edited screenshot is now saved.

You finished reading the article "How to Edit a Screenshot" edited by the TipsMake team. We hope this article
has provided you with many useful tech tips and tricks. You can search for similar articles on tips and guides.
Thank you for reading and for following us regularly.
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